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Getting Started

The Windows Interface Language (WIL) is an easy-to-use yet very 
powerful general-purpose programming language with over 500 
functions for file management, sending keystrokes, disk drive 
management, directory management, binary file access, multimedia 
support, DDE support, clipboard handling, system control, program 
management, string handling, displaying information, user prompting, 
window management, floating point & integer arithmetic, execution 
control and more. Many operations that require pages of code in other 
programming languages can be accomplished with a single WIL 
function call.    WinBatch Studio provides an editing environment for 
creating scripts with the Windows Interface Language.    

WIL is supported by several Wilson WindowWare products, including 
WinBatch, WinBatch+Compiler, WebBatch, FileMenu, PopMenu and 
WinEdit. Some implementations of WIL include capabilities not 
described here (for example, WebBatch includes functions that are 
useful only in an Internet World Wide Web server environment, and 
leaves out those that don't make sense in that environment such as 
window management). 

            What is WIL   

            Contacting   
WilsonWindowWare

            Step by step   
guide to learning WIL 

            Finding Help  



WinBatch Studio Menus
Select a menu for further information on menu options

File menu
Edit menu
View menu
Search menu
Debug menu 
Window menu
Help menu



File menu commands

The File menu offers the following commands:

New Creates a new document. 
Open Opens an existing document.
Close
Close All
Merge

Closes an opened document.
Closes all opened documents.
Inserts the contents of a new document into the current document.

Save Saves an opened document using the same file name.
Save As
Save All
Revert
Page Setup

Saves an opened document to a specified file name.
Saves all opened documents.
Rereads the current document from disk, returning to its original state.
Displays printing options.

Print Setup Selects a printer and printer connection.
Print Prints a document.
Print Preview Displays the document on the screen as it would appear printed.
Send...
Properties

Sends the active document through electronic mail.
Displays information about the current document.

Recent File
Exit

Displays a list of previously opened documents.
Exits WinBatch Studio.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Redo Reverse previous undo operation.
Cut Deletes data from the document and moves it to the clipboard.
Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.
Delete Deletes data from the document.
Copy 
Other

Copies specific data from the document to the clipboard.

Cut 
Other

Cuts specific data from the document to the clipboard.

Change 
Case

Changes the case of selected data from the document.

Select 
All

Selects all the data in the document.



View menu commands
The View menu offers the following commands:

Toolbars Shows, hides, or customizes the toolbars.
Status Bar Shows or hides the status bar.
Output Shows or hides the output window.
Watch Shows or hides the watch window.
Options Editor, keyboard, and file specific settings are 

maintained in this dialog box.



Search menu commands

The Search menu offers the following commands:

Find Searches the current document for the specified text.
Find next Repeats the last find operation, using the same options.
Replace Searches the current document for the specified text, and

replaces the found text with specified text.
Find In Files Searches one or more files for the specified text.
Match Brace If the caret is placed on a brace character ( ().{}, or []    the

caret is moved to the matching brace character.



Debug menu commands
WinBatch Studio offers a complete interactive debugging environment 
for WIL script files.    To debug a WIL script, first make sure the saved 
file is loaded and is the active document.

See Also:
Debugging WIL 
Scripts

The Debug menu offers the following commands:
Run
Dialog Editor

Runs the script in the active window.
Provides a convenient method of creating dialog box 
templates for use in your WinBatch programs. 

Compile Executes the Compile command defined in the Options / 
File Type dialog box.

Customize 
Tools...

Allows a program or WIL script to be added to the Project 
menu.

Debug Begins executing the script commands.    Execution will 
continue to the end of the script or until a breakpoint is 
encountered.

Step Into Executes the current line of the script.    If the current line 
is a goto, gosub, or call command, execution stops at the 
first line of the goto, gosub, or call code.

Step Over Executes the current line of the script.    If the current line 
is a goto, gosub, or call command, all the code at the goto,
gosub, or call location is also executed.

Run To Cursor Begins executing script commands at the current location 
and continues to the point in the script where the cursor 
(caret) is located.

Stop 
Debugging

Stops execution of the script.

Insert/Remove
Breakpoint

Inserts a breakpoint at the current line, or removes it if it 
already exists.    When execution of the script is initiated 
with the Go or Run To Cursor commands, execution will 
still stop if a line with a breakpoint is encountered.

Remove All 
Breakpoints

Removes all defined breakpoints in the current script.



Customize Tools
Programs can be added to the Debug Menu either with the Customize Tools / Add button or by 
recording and saving a macro.    

In this dialog, 
Difference is 
added as an 
example.    

Click on a dialog 
box item for more 
information.



Window menu commands
The Window menu offers the following commands, which enable you to arrange multiple views of 
multiple documents in the application window:

New Window Creates a new window that views the same document.
Split Split the active window into panes.
Cascade Arranges windows in an overlapped fashion.
Tile 
Horizontally

Arranges windows in non-overlapped tiles.

Tile Vertically Arranges windows in non-overlapped tiles.
Close All Closes all open windows.

Arrange Icons Arranges icons of closed windows.
Window 
manager

Lists all open windows.    Multiple selections may be made.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Help 
Contents

Offers you an index to topics on which you can get help.

About 
WinBatch 
Studio

Displays the version number of this application.

WinBatch and the WinBatch + Compiler are comprised of many pieces; the Windows Interface 
Language, special WinBatch specific commands and extenders for networking, just to name a few.   
Each of these pieces has its own help file which can be accessed quickly and easily from WinBatch 
Studio's configurable context menu.    Clicking the right mouse button anywhere within an open file 
will bring up the context menu. 



Finding Help

WinBatch and the WinBatch + Compiler are comprised of many 
pieces; the Windows Interface Language, special WinBatch specific 
commands and extenders for networking, just to name a few.    Each 
of these pieces has its own help file which can be accessed quickly 
and easily from WinBatch Studio's configurable context menu.    

Clicking the right mouse button anywhere within an open file will bring
up the context menu. 

See Also:
Context Menu

Menu file 
structure.

Contacting 
WilsonWindowWa
re

To make changes to the context menu, open the 
WSPOPUP.MNU file with File/Open, or access it from the 
context menu itself.    Right click in the file, from the context 
menu dialog box select More / How do I? / Customize this
menu.



Context Menu

WinBatch Studio has a completely configurable context menu 
accessed by clicking the right mouse button anywhere within an open 
file.    Right clicking results in a dialog box filled with many useful 
macros.    Using the Windows Interface Language, you can write your 
own macros and place them on this menu for easy access. 

See Also:
Menu file structure.

Finding Help

To make changes to the context menu, open the 
WSPOPUP.MNU file with File/Open, or access it from the 
context menu itself.    Right click in the file, from the context 
menu dialog box select More / How do I? / Customize this
menu.

In order to place your items successfully onto the Context menu, you must follow a few guidelines.    
    Menus can be up to four levels deep. 

    Levels are determined by the position of the first letter in the menu title. 

    The top level menu starts at Column 1, the second starts in Column 2, and so on. The WIL code must 
begin at Column 5 or greater. 

    Same level menu items must be separated by WIL code. 

That's it.    Those are the simplified rules.    
For more information on personalizing the context menu see Menu file structure in the Windows Interface
Language Help file.



Debugging WIL Scripts
WinBatch Studio is used to both edit and debug scripts.    

There are various ways to debug a script.

See Also:
Debug Menu

Experienced programmers who can write relatively bug-free code might 
just write a script and then hit the Go button and see if it works.        If an 
error occurs, the line causing the error on it will be indicated and the 
current state of all variables displayed.

The rest of us will find that debugging a script is a more interesting 
process.    We might write a few lines of code and then press the Step 
Into button to step through the code one line at a time.    As each line is 
executed the current state of all variables is displayed in a special 
watch window.

Once large sections of code are bug free, it becomes rather boring to 
step, step, step through each statement.    There are several different 
solutions to this problem.    One is the Step Over button that can be 
used to execute entire sections of code in a GoSub or Call function.    In
addition there is a Run to Cursor hot-key combination (Ctrl-F10) and 
menu item that allows you to place the mouse cursor on a line and 
execute to that point.    In this way, it is possible to avoid step, step, 
stepping through large blocks of code.

For serious debugging there are breakpoints.    Breakpoints are useful 
where there is a large quantity of code and you are interested in 
debugging a specific section of it.    To use breakpoints you    click on a 
line of code and hit the Insert/Remove Breakpoint button.    A red 
square will appear next to the line indicating a breakpoint is active on 
the line.    Next you would click the Go button.    The script will start 
executing and will stop when it hits a line with a breakpoint.    You may 
have several different lines with breakpoints.    

The Watch Window allows you to view the contents of script variables. 
From the View Menu select the Watch menu option to display the 
Watch Window at the bottom of the document area.    Step through a 
script that contains several variables and observe the changing values.  
Notice that the latest variable assignment is displayed as the first line of
text in the window.      

Not only can you observe variable values, you can also change them.    
To make a change double-click on the variable name in the Watch 
Window, type a new value and click the OK button in the dialog that 
appears.    Continue stepping to see the effect of your change.        

Why change a value?    It may not be necessary in simple scripts. 
However, as your scripts become more complex the relationships 
between values and results may not be obvious.    The suspected cause



of a bug can quickly be verified or eliminated by placing a known good 
or bad value in a variable.

Also, the best time to test a block of script is right after you write it.    
When will you know it better?    By setting variables in the debugger you
can determine how your code fragment or subroutine will behave when 
it encounters normal, extreme and out of range values.    This can be 
accomplished without having to write throwaway test driver scripts.    
You will be much more confident in your final script, if you know that 
each element is doing its job.



Toolbars
WinBatch Studio has four configurable toolbars; File, Window, Debug and Tools.

File The File bar displays buttons for the typical File 
Management commands; Open, Save, Print etc.

Window The Window bar allows for easy selection of 
window viewing options; Tiled; Cascade etc.

Debug The Debug bar displays buttons for the WIL script 
debugging commands

Tools The Tools bar displays programmable buttons for 
user defined tools.

 

See Also:

            Toolbar Dialog Box  

            Debug Menu  

            Print Preview Toolbar  



Toolbars dialog box
The View / Toolbars dialog box offers the following paged dialog boxes:

Toolbar Place a check mark by the toolbars you wish to display.    
Click New to add additional toolbars you can create. 
Highlight a standard toolbar and click Reset to restore the 
toolbar to its original state.

Commands Shows all available toolbar buttons for each standard toolbar.
To customize toolbars, drag a button to or from this dialog 
box to any toolbar on display.





Options dialog box
Preferences for WinBatch Studio are set from the Options View menu in one of the following paged 
dialog boxes.

Editor Sets general options for WinBatch Studio.
File type Sets options for specific file types.



Options - Editor tab
The View / Options Editor dialog page offers the following items:

Click on a dialog box item for more information or scroll down for a complete list of 
option descriptions.

Restore workspace at 
startup

Reload all documents that were open at the
end of the last editing session.

Leave cursor at start of 
pasted text

When checked, the cursor (caret) is 
positioned at the beginning of the pasted 
text.    When unchecked, it is placed at the 
end of the pasted text.

Allow multiple instances of 
WinBatch Studio

When unchecked, double clicking an 
associated file or starting WinBatch Studio 
itself activates the already running instance 
instead of launching an additional copy.

Show horizontal scrollbar When unchecked, no horizontal scrollbar is 
shown.



Allow virtual whitespace When checked, the caret can be positioned 
in any column.    When unchecked, the 
caret cannot be moved beyond the end of 
the text of any line.

Make backup files When checked, a backup copy of a 
document is made whenever the document 
is saved.

Backup specification Create a file specification to use when 
naming a backup file.    Choose options 
based on the original document name from 
the menu button.

Automatically backup files When checked, a backup copy of a 
document is made automatically at the time
interval selected.

Autosave file specification Create a file specification to use when 
naming an autosave file.    Choose options 
based on the original document name from 
the menu button.



Options - File types tab
In WinBatch Studio, many editing options are associated with a particular file type.    WinBatch Studio 
classifies file types based upon the file extension.    

Click on a dialog box item for more information or scroll down for a complete list of 
option descriptions.

File type Chooses a file type from the dropdown list.
Syntax coloring Sets options for coloring keywords for this file type,

and for specifying the characters which flag text as
a comment.

Font Selects a fixed pitch font to be used to display this 
file type.

Tab size Sets the number of columns each tab character 
represents.

Show tabs When selected, tab characters are displayed on 
screen.

Insert spaces/Keep Selects whether to insert a tab character, or a 



tabs corresponding number of space characters, when 
pressing the tab key.

Insert mode When checked, text typed is inserted at the caret 
position.    When unchecked, overtype mode is 
used, where text typed replaces text at the caret 
position.

Line End Selects the characters that are inserted when the 
Enter key is pressed.

Compile command Enter the command line used to compile this file 
type.    Command line parameters based upon the 
original document name can be selected from the 
menu button.



Syntax coloring

Syntax Coloring sets options for coloring keywords and characters which comment text for the 
selected file type.    This option can be accessed through the View / Options File types dialog 
box.

WinBatch Studio has predefined settings for the following file types; .BAT, .HTML, .TXT and the 
various WIL file types, (WIL, WBT, MNU, MNW, and MAC.)    Any unrecognized file extension 
will automatically use the settings under "Default Files".



Font Selection

The font which appears on the screen is not necessarily the font used when you print.    Print and Screen 
Fonts are established using separate Font Dialog boxes.

Print Font
From the File menu Page Setup command, use the radio button to emulate the Screen Font or 
select the Printer Font button to change your Printer font.

Screen Font
From the View menu Options File type command, the Font button selects a fixed pitch font to be 
used to display the selected file type.



Page Setup

The following options allow you to set print options for each page that will be printed.
Click on a dialog box item for more information.



Print Setup

Use this command to select a printer and a printer connection.    This command presents a Print 
Setup dialog box, where you specify the printer and its connection.

Click on a 
dialog box 
item for 
more 
information 
or scroll 
down for a 
complete list
of option 
descriptions.

Printer Select the printer you want to use.    Choose the Default Printer; or choose the 
Specific Printer option and select one of the current installed printers shown in the 
box.    You install printers and configure ports using the Windows Control Panel. 

Orientation Choose Portrait or Landscape.

Paper Size Select the size of paper that the document is to be printed on.

Paper Source Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options Displays a dialog box where you can make additional choices about printing, 
specific to the type of printer you have selected.

Network Choose this button to connect to a network location, assigning it a new drive letter.



Print

Use this command to print a document.      
The Print command presents the Print dialog box, where you may specify the range of pages to be 
printed, the number of copies, the destination printer, and other printer setup options.

Click on a 
dialog box 
item for 
more 
information 
or scroll 
down for a 
complete list
of option 
descriptions.

Printer This is the active printer and printer connection.    Choose the Setup option to change the 
printer and printer connection.

Properties Displays a Properties dialog box, so    you can select a printer and printer connection.
Print Range Specify the pages you want to print.

All Prints the entire document.
Selection Prints the currently selected text.
Pages Prints the range of pages you specify in the From and To boxes.

Copies Specify the number of copies you want to print for the above page range.
Collate Copies Prints copies in page number order, instead of separated multiple copies of each page.



Print Progress Dialog

The Printing dialog box is shown during the time that WinBatch Studio is sending output to the 
printer.    The page number indicates the progress of the printing.
To abort printing, choose Cancel.



Print Preview

Use this command to display the active document as it would appear when printed.    When you 
choose this command, the main window will be replaced with a print preview window in which one 
or two pages will be displayed in their printed format. 
The print preview toolbar offers you options to view either one or two pages at a time; move back 
and forth through the document; zoom in and out of pages; and initiate a print job.
The number of pages displayed in Print Preview also depends upon whether the Two Up printing 
mode is selected in the Page Setup dialog box.    If Two Up is selected, the font size will 
automatically become smaller and the orientation of the page will change to Landscape.

One Up Printing / 
One Page Preview

One Up Printing / 
Two Page Preview

Two Up Printing / 
Two Page Preview



Print Preview Toolbar
The print preview toolbar offers you the following options:

Print Bring up the print dialog box, to start a print job.
Next Page
Prev Page
One Page / Two Page

Preview the next printed page.
Preview the previous printed page.
Preview one or two printed pages at a time.

Zoom In
Zoom Out
Close

Take a closer look at the printed page.
Take a larger look at the printed page.
Return from print preview to the editing window.



Copyright

Copyright © 1988-1998 
Steve Schauer, Morrie Wilson

All rights reserved.

No part of this manual may be reproduced or transmitted 
in any form or by any means, electronic or mechanical, 
including photocopying and recording, for any purpose 
without the express written permission of Wilson 
WindowWare, Inc.    Information in this document is subject
to change without notice and does not represent a 
commitment by Wilson WindowWare, Inc.

The software described herein is furnished under a license
agreement.    It is against the law to copy this software 
under any circumstances except as provided by the 
license agreement.

U.S. Government Restricted Rights
Use, duplication, or disclosure by the Government is 
subject to restrictions as set forth in subdivision (b)(3)(ii) of
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What is WIL?
Windows Interface Language (WIL) is an easy-to-use yet very 
powerful general-purpose programming language with over 500 
functions for file management, sending keystrokes, disk drive 
management, directory management, binary file access, 
multimedia support, DDE support, clipboard handling, system 
control, program management, string handling, displaying 
information, user prompting, window management, floating point 
& integer arithmetic, execution control and more. Many 
operations that require pages of code in other programming 
languages can be accomplished with a single WIL function call.

WIL scripts are written in a plain text file, which can be created 
by Notepad or most word processors. (Of course, we 
recommend our own WinBatch Studio, which has many features 
designed expressly for programmers, including a full-featured 
implementation of WIL itself.)

These text files can take one of two forms, depending on your 
particular implementation of WIL: batch files or menu files.

Batch Files
A batch file is simply a list of WIL commands and function 
calls, executed in order (just like the old DOS batch 
language).

Menu Files
A menu file is similar to a batch file, except that multiple 
chunks of WIL code are organized into menu and sub-
menus, and each routine is launched by pressing the 
appropriate keystroke or selecting an item from the menu. 
(The name and location of the menus vary depending on the
particular implementation of WIL menu files.) 

            What WIL is good for  

            Products that use WIL  

            Using WIL  

            Reference  

            Step by step guide to   
learning WIL



Menu Files
WIL scripts can be implemented in two ways: via batch files    
or menu files. In a batch    process, WIL scripts are associated 
with the WIL processor, allowing them to be initiated and run on
the desktop just as any true executable is launched and run. 

WIL scripts can also be launched as menu items from a drop 
down menu. However, you must have an implementation of 
WIL with the capability of generating the menu either within one
of our applications or as an enhancement to standard Windows 
applications. In Windows 95/98/NT, WIL adds menu capability 
to the Windows Task Bar and the Shortcut Menu in the 
Windows 95/98/NT Explorer. 

Please see either the help file or printed documentation that 
came with your program for more information.

            Menu file structure   

            Modifying menus   

            Menu hotkeys   

            Menu items   

            Batch files   

            Products that use WIL  

            Reference  

            Step by step guide to   
learning WIL 



WinBatch and the WinBatch + Compiler are comprised of many pieces; the Windows Interface 
Language, special WinBatch specific commands and extenders for networking, just to name a few.    

Each of these pieces has its own help file which can be accessed quickly and easily from WinBatch 
Studio's configurable context menu.    Clicking the right mouse button anywhere within an open file will 
bring up the context menu. Select the option "Help files", then a help file name from the drop down list.

Windows Interface 
Language Help

            Function List  

            Using WIL  

            WIL Help Contents  

            Step by step guide to learning WIL   

WinBatch Help
            Function List  

            Using WinBatch  

            WinBatch Help Contents   



Step by step guide to learning WIL
The Windows Interface Language (WIL) is a scripting 
language.    In order to use it, you must open up an 
editor and Create a Script using the WIL commands. 
Once written, the script is saved and run with an 
extension already associated with the WIL interpreter.    
In our examples, we use the extension .WBT.    

The WIL language is not hard to learn. A general 
knowledge of batch file programming is helpful, but not 
necessary. 

Suggestions for Tutorial use
Everyone has different learning styles.    The contents of
the WIL Tutorial can be accessed in several ways.

Topic by Topic    -    Arranged so each new concept builds 
on the last.    Scroll through the topics from 
the top or select the ones which catch your 
eye. 

Step by Step Tutorial Course    -    For those who have the 
general idea and don't want to be bogged 
down with the absolute particulars. Follow 
along and write a working script.

The Complete Tutorial    -    For some, the printed word is 
mightier than the hypertext jump. Here the 
tutorial has been arranged for easy printing.    

The WIL Tutorial 
            The Complete WIL   

Tutorial
            Topic by Topic  
            The Tutorial Course  

            Getting started  
            Using WIL  
            Reference  
            Notational   

Conventions
            Notes  



Contacting Wilson WindowWare
            Wilson WindowWare, Inc.
            5421 California Ave. SW
            Seattle, WA 98136 USA

            Orders: (800) 762-8383
            Voice: (206) 938-1740
            Fax: (206) 935-7129

            Email: info@windowware.com

…..
Registered users of our software receive: manuals, technical
support, use of Wilson WindowWare on-line information 
services, and special offers on new versions of Wilson 
WindowWare products. 

            Registering your copy  

            Ordering Information  

            Order form  

            Technical support   



How to get technical support
The Wilson WindowWare website is an excellent technical 
resource. Access to the entire Technical Support Database is 
at your fingertips. In the Technical Support area use the 
keyword search to find answers to common problems, 
alternate scripting methods, and sample code.    Or join the 
Wilson WindowWare Web BBS, a new Web forum.    The BBS
provides an outlet for registered users to share their 
experiences with other users. 

See the information on registering your copy if you haven't 
done so yet.

The latest versions of our software are available on-line. The 
places here may change at any time -- check your installation
sheet for the most recent addresses.

Internet Web page: http://www.windowware.com 

Internet Technical Support Articles & Web BBS: 
http://techsupt.windowware.com

Internet FTP: ftp.windowware.com in /wwwftp/wilson

            Registering your copy  

            Ordering Information  

            Order form  

            Reference  

            Step by step guide to   
learning WIL 



Registering your software
Registered users of our software receive: manuals, 
technical support, use of Wilson WindowWare on-line 
information services, and special offers on new versions of 
WinBatch and other Wilson WindowWare products. 
You can register online, through our secure commerce 
server:

            http://commerce.windowware.com

You can register your software by mailing your registration 
card, faxing your registration card, or calling Wilson 
WindowWare. 

            Wilson WindowWare, Inc.
            5421 California Ave. SW
            Seattle, WA 98136 USA

            Orders: (800) 762-8383
            Voice: (206) 938-1740
            Fax: (206) 935-7129

            Ordering Information  

            Order form  

            Contacting   
WilsonWindowWare



Ordering Information
Licensing our products brings you wonderful benefits. Some of 
these are: 

Gets rid of that pesky reminder window that comes up 
when you start up the software. 

Entitles you to one hour free phone support for 90 days
(Your dime). 

Ensures that you have the latest version of the product.
Encourages the authors of these programs to continue 

bringing you updated/better versions and new products. 
Gets you on our mailing list so you are occasionally 

notified of spectacular updates and our other Windows 
products. 

And, of course, our 90-day money back guarantee. 

International customers
Although we do prefer payment by Credit Card we can accept
non-US-bank checks under certain conditions. The check 
MUST be in your currency -- NOT IN US$ -- Just look in your 
newspaper for the current exchange rates, make out your 
check and send mail it to us. We will take care of the rest. No 
Eurocheques please. 

                  Send to:    Wilson WindowWare, Inc.
                                        5421 California Ave. SW 
                                        Seattle, WA 98136 
                                        USA 

              or call:    (800) 762-8383    (USA orders only )
                                        (206) 938-1740    (customer service)
                                        (206) 937-9335    (tech support)
                                        (206) 935-7129    (fax) 

(Please allow up to 2-3 weeks for delivery)

            Order form  

            Contacting   
WilsonWindowWare



WILSON WINDOWWARE ORDER FORM

WILSON WINDOWWARE
5421 California Ave. SW 
Seattle  WA 98136
Ph - (206)938-1740
Fax - (206)935-7129

            Contacting   
WilsonWindowWare

 Name: ________________________________________________

 Company:_______________________________________________

 Address:________________________________________________

________________________________________________________

City:      ________________________    St:______    Zip:___________

Phone: (______)_________________        
Country:________________

Products

____ WinBatch      @    $99.95 : _______.____    

____ WinBatch    Compiler @$495.00 : _______.____    

____ WinBatch Studio @    $99.95 : _______.____    

Shipping
____ US and Canada shipping @        $5.00 : _______.____    

____ Foreign air shipping
                (except Canada) @    $14.50 : _______.____

                Total :    _______.____

Please enclose a check payable to Wilson WindowWare or you may use Access, Amex, 
Visa, MasterCharge, or EuroCard.      For credit cards,    please enter the information below:

 Card #:__ __ __ __ - __ __ __ __ - __ __ __ __ - __ __ __ __          Expiration date: ____/____

 Signature:    _________________________________________
 
 Where did you hear about or get a copy of our products?

________________________________________________________



International customers please see note on previous page.
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Help file produced by    HELLLP! v2.7 , a product of Guy Software, on 10/29/98 for WILSON 
WINDOWWARE, INC..
The above table of contents will be automatically completed and will also provide an 
excellent cross-reference for context strings and topic titles.    You may leave it as your main 
table of contents for your help file, or you may create your own and cause it to be displayed 
instead by using the I button on the toolbar.    This page will not be displayed as a topic.    It is
given a context string of _._ , but this is not presented for jump selection.
HINT:    If you do not wish some of your topics to appear in the table of contents as displayed 
to your users (you may want them ONLY as PopUps), move the lines with their titles and 
contexts to below this point.    If you do this remember to move the whole line, not part.    As 
an alternative, you may wish to set up your own table of contents, see Help under The 
Structure of a Help File.
    Do not delete any codes in the area above the Table of Contents title, they are used 
internally by HELLLP!

Page Setup



Header / Footer
Select optional Header/Footer print fields from the drop down list.



Print Options

Two up Printing Prints two pages side by side in Landscape format.
(Font may appear smaller than selected Screen or Printer font.)

Line numbers Prints line numbers in the left hand margin.
Color syntax printing Prints document using the designated color syntax highlighting for 

that file.



Font
Mirror Screen Font Emulates the Screen font while ignoring Printer Font information.
Use Printer Font Uses the font selected in the Printer font dialog.



OPTIONS Editor



Restore workspace at startup
Reload all documents that were open at the end of the last editing session.

Leave cursor at start of pasted text
When checked, the cursor (caret) is positioned at the beginning of the pasted text.    
When unchecked, it is placed at the end of the pasted text.

Allow multiple instances of 
When unchecked, double clicking an associated file or starting    itself activates the 
already running instance instead of launching an additional copy.



Show Horizontal Scrollbar
When unchecked, no horizontal scrollbar is shown.

Allow Virtual Whitespace
When checked, the caret can be positioned in any column.    When unchecked, the 
caret cannot be moved beyond the end of the text of any line



Make backup files
When checked, a backup copy of a document is made whenever the document is 
saved.

Backup specification
Create a file specification to use when naming a backup file.    Choose options based 
on the original document name from the menu button.



Automatically backup files
When checked, a backup copy of a document is made automatically at the time 
interval selected.

Autosave file specification
Create a file specification to use when naming an autosave file.    Choose options 
based on the original document name from the menu button.



Options FileType dialog box



File type
Chooses a file type from the dropdown list.



Edit
Allows adding or deleting of file types from the list.



Syntax coloring
Sets options for coloring keywords for this file type, and for specifying the characters which 
flag text as a comment.



Font
Selects a fixed pitch font to be used to display this file type.



Tab size
Sets the number of columns each tab character represents.
Show tabs
When selected, tab characters are displayed on screen.



Insert spaces/Keep tabs
Selects whether to insert a tab character, or a corresponding number of space characters, 
when pressing the tab key.



Insert mode
When checked, text typed is inserted at the caret position.    When unchecked, overtype 
mode is used, where text typed replaces text at the caret position.



Line End
Selects the characters that are inserted when the Enter key is pressed.



Run command
Enter the command line used to run this file type.    Command line parameters based upon 
the original document name can be selected from the menu button.



Print Preview



Print
Bring up the print dialog box, to start a print job.



Next Page
Preview the next printed page.



Prev Page
Preview the previous printed page.



One Page / Two Page
Preview one or two printed pages at a time.



Zoom In
Take a closer look at the printed page.



Zoom Out
Take a larger look at the printed page.



Close
Return from print preview to the editing window.



Print Dialog



Printer
This is the active printer and printer connection.    Choose the Setup option to change 
the printer and printer connection.



Properties
Displays a Print Properties dialog box, so    you can select a printer and printer 
connection.



Print Range
Specify the pages you want to print:

All Prints the entire document.
Selection Prints the currently selected text.
Pages Prints the range of pages you specify in the From and To 

boxes.



Copies
Specify the number of copies you want to print for the above page range.



Collate Copies
Prints copies in page number order, instead of separated multiple copies of each 
page.



DEBUG



Go
Begins executing the script commands.    Execution will continue to the end of the 
script or until a breakpoint is encountered.



Step Into
Executes the current line of the script.    If the current line is a goto, gosub, or call 
command, execution stops at the first line of the goto, gosub, or call code.



Step Over
Executes the current line of the script.    If the current line is a goto, gosub, or call 
command, all the code at the goto, gosub, or call location is also executed.



Run To Cursor
Begins executing script commands at the current location and continues to the point 
in the script where the cursor (caret) is located.



Stop Debugging
Stops execution of the script.



Insert/Remove Breakpoint
Inserts a breakpoint at the current line, or removes it if it already exists.    When 
execution of the script is initiated with the Go or Run To Cursor commands, execution 
will still stop if a line with a breakpoint is encountered.



Remove All Breakpoints
Removes all defined breakpoints in the current script.



PRINT SETUP



Printer
Select the printer you want to use.    Choose the Default Printer; or choose the 
Specific Printer option and select one of the current installed printers shown in the 
box.    You install printers and configure ports using the Windows Control Panel.



Orientation
Choose Portrait or Landscape.



Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.



Properties
Displays a dialog box where you can make additional choices about printing, specific 
to the type of printer you have selected.



Project Customize Tools



Buttons
Add / Remove            Adds or removes items.

Move up / 
Move down                  Changes the position of an item in the list.



Menu Text
The text which will appear on the Project Menu.    An & before the first character 
creates a hotkey.    



Arguments

The command line 
parameters 
required for the 
program.    

Arguments, can be 
selected from the 
drop down list.

Initial Directory
The directory set to be the current directory when the command is executed.




